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Chapter 1

SL2100

Introduction

PC Programming, referred to as PCPro, is an application used to manage the 
SL2100 system. PCPro is rich with features to help users more easily manage a 
chassis when compared to handset programming.

The user can perform the following when using PCPro:

 Upload/Download settings between PCPro and a chassis.

 Save settings to files that can be archived for later use.

 Program settings grouped by their relationship via standard screens.

 Generate reports that can be used to monitor settings.

 Automatically update chassis firmware remotely.

 Export settings to files for later use.

 Capture low level messages to problem solve through the Debug Terminal.
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Chapter 2

SL2100

Installation

SECTION 1 SYSTEM REQUIREMENTS

The process of installing PCPro is straight-forward. Just run the installation program 
and follow the instructions. Table 2-1 System Requirements lists the minimum 
system requirements necessary for install PCPro on your computer.    

SECTION 2 DEFAULT PCPRO ACCOUNTS

When installing PCPro for the first time, the installation program creates a set of 
default PCPro accounts. The accounts with the user name and password to access 
these accounts are provided in Table 2-2 Default PCPro Accounts.   

Table 2-1  System Requirements

System: Minimum Requirements

CPU
CPU and Memory are dependent on the Microsoft Operating System 
environment used.

Memory

OS Vista, Windows 7 (32/64bit), Windows 8/8.1

Other Microsoft Internet Explorer 7.0/8.0/9.0/10.0

Communication port LAN, Modem or ISDN

Disk Space 1GB for PCPro (minimum)

TCP Port

PCPro must have TCP port 8000 open between the chassis and the 
host PC. Communications between PCPro and the chassis occurs 
on this port when uploading / downloading via LAN.
The PCPro TCP port is 8000 at default, but this can be changed 
through the Administration>WebPro Settings section of WebPro 
using PRG 90-54-02. PRG 90-54-02 is not accessible from 
telephone programming or PCPro.
The port to be used for debug should be defined in 10-20-06.

Table 2-2  Default PCPro Accounts

User Name Password Access Level

tech 12345678 Installer Mode (IN)
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In addition, the installation program will create the following default folders:  

ADMIN1 0000 System Administrator Mode 1 (SA)

ADMIN2 9999 System Administrator Mode 2 (SB)

NOTE


An install/uninstall does not remove or modify any existing PCPro Accounts, or 
Connection Accounts.

Table 2-3  Default Folders

Folder Name/Icon Location Description

My Databases <install dir>\databases
Default folder where PCPro databases 
are saved.

DebugTerm <install dir>\logfiles
Default folder where PCPro Debug 
Terminal log files are saved.

Reports <install dir>\reports
Default folder where PCPro reports are 
saved.

exports <install dir>\exports
Default folder where PCPro exported 
files are saved.

NOTE


An install/uninstall does not result in the folder or any files in the folder being 
deleted.

Table 2-2  Default PCPro Accounts (Continued)

User Name Password Access Level
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SECTION 3 SOFTWARE INSTALLATION

The software can be installed from the application CD, provided with the chassis or 
downloaded from the web.

1. Launch the installer.

2. When the installer launches, the InstallShield Wizard Welcome screen is 
displayed. Press Next>.

If you do not want to continue, click Cancel to abort the installation and exit the 
software.    

 

Figure 2-1  InstallShield Wizard Welcome Screen
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3. To install the program, click Install.

If you wish to return to the previous screen, click <Back.

If you do not want to continue, click Cancel to abort the installation and exit the 
software.   

Figure 2-2  InstallShield Wizard Begin Installation
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4. The program installs.  Figure 2-3 InstallShield Wizard Installation Progress 
shows the screen you will see that indicates the progress of the installation.

If you wish to return to the previous screen, click <Back.

If you do not want to continue, click Cancel to abort the installation and exit the 
software.   

Figure 2-3  InstallShield Wizard Installation Progress
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5. When the installation is completed, Figure 2-4 InstallShield Wizard Finish 
Installation is displayed. Click Finish.    

Figure 2-4  InstallShield Wizard Finish Installation
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SECTION 4 LAUNCHING THE APPLICATION SOFTWARE

Once the application software has successfully installed you can launch the 
application in one of two ways:

 Click the PCPro shortcut icon that was placed on your desktop during installation.  

-- OR --

 Select the program by clicking Start > All Programs > NEC > SL2100 PCPro > 
SL2100 PCPro.  

Figure 2-5  SL2100 PCPro Desktop Shortcut

Figure 2-6  InstallShield Wizard Launch Software
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The PCPro Welcome screen is displayed.  

Figure 2-7  PCPro Main Menu
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Chapter 3

SL2100

Application Layout

SECTION 1 INTRODUCTION

The programming section of PCPro provides methods to view and edit values 
associated with a chassis configuration.  Most programming is done using two 
different views: Standard and System Data. These methods can be accessed 
through the menu item Programming.  Accessing these items updates the 
applications Sub-menu and Workspace areas. The Status bar gives a status 
indication of various functions related to PCPro (e.g., connection status, version 
information).

The general PCPro application layout is shown in Figure 3-1 PCPro Application 
Layout.   

Figure 3-1  PCPro Application Layout

Submenu Status Bar Workspace

Ribbon Bar
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SECTION 2 MENU

The menu displays the list of functions available in PCPro. Some of these commands 
have images next to them so you can quickly associate the command with the image. 
The full list of the PCPro menu hierarchy is found in  - Menu and Toolbar Reference.

SECTION 3 TOOLBAR

The Toolbar is not opened by default. It is opened by going to View. The Toolbar is a 
group of buttons that map to items in the application menu. The toolbar allows for 
quick and convenient access to the most common PCPro commands. The items on 
the toolbar are shown in Figure 3-2 PCPro Toolbar.             

The full list of the PCPro menu and toolbar hierarchy is found in  - Menu and Toolbar 
Reference.

SECTION 4 SUB-MENU AREA

The Sub-menu area is used to navigate through Standard View (refer to  - Standard 
View) and System Data (refer to  - System Data View). Selections made from the 
sub-menu area updates the workspace with the related settings.

NOTE


The keyboard shortcuts (where applicable) are listed below the toolbar 
identification in Figure 3-2 PCPro Toolbar.

Figure 3-2  PCPro Toolbar

File New
(Ctrl+N)

File Open
(Ctrl+O)

File Save
(Ctrl+S)

Standard View
(F9)

Easy Edit
(F10)

System Data Programing
(F11)

Search
(F3)

Connect/Disconnect

Download
(F6) (Ctrl+D)

Upload
(F7) (Ctrl+U)

Modification 
History Report

System Data Reports

Verify
(F8)

Debug Capture

Navigation 
Filters

Help
(F1)

System Configuration
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SECTION 5 WORKSPACE

The Workspace is where all programming occurs. The Workspace consists of 
various selections made from the Sub-menu Area and the Workspace itself. 
Common Workspace components are further explained.  

Figure 3-3  PCPro Workspace

Workspace ButtonsNavigation AreaData AreaSubtitleTitle

Help Area
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5.1 Title

Title describes what the current settings in the Workspace are related to. This is 
associated with the selection made in the Submenu Area. The title is situated at 
the top left corner of the Workspace.

5.2 Subtitle

Subtitle shows further information about what the you are programming.

5.3 Workspace Buttons

The Workspace buttons area displays different buttons relevant to current 
programming. These buttons include:   

Table 3-1  Workspace Buttons 

Button Description

Apply sets changes recently made on the active screen. Attempting 
to apply an invalid value prompts a validation message detailing the 
error.  In this case, changes are not applied until the value is made 
valid.

Default Cell sets all highlighted cells back to the default program 
setting. 

Paste applies copied contents into the selected location.

Copy shows the Copy dialog. Refer to  - Copy for more information.

Default resets the active screen to the system default values.

Form View is the default view, which displays the values with pull 
down boxes. Note that this option is not available on all screens.
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When you do not click the Apply button, but do one of the following, the system 
applies the changes as if you had clicked the Apply button.

 Attempt to leave the current screen.

 Attempt to navigate a different item within the system data.

 Use the Previous button.

 Use the Next button.

 Save the active configuration.

 Exit the application. (Note that on some screens, the system prompts you to 
save the changes or to exit without saving them.)

 Generate a report.

Grid View is available on screens that have a large number of 
values that must be entered (e.g., screens with telephone 
extensions). When Grid View is selected, the screen switches to a 
table format, allowing you to easily enter a large number of values 
for a specified extension.

For example, if assigning your incoming virtual ring tones for internal 
extensions, you can switch from Form View to Grid View to list all of 
the extensions in table format. Note that this option is not available 
on all screens.

Table 3-1  Workspace Buttons  (Continued)

Button Description
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5.4 Navigation Area

To navigate to different items within a program, use the various navigation 
buttons.  

 

Figure 3-4  PCPro Navigation Buttons

Select an item to view

Move to the previous item

Move to the next item

Navigation Filters

Move to specified items

Table 3-2  Navigational Buttons and Drop Down List

Button/Menu Description

Selections Select the item from the drop down list. PCPro 
automatically moves to the selected item.

Ranges Use this button to select a range of values.  Type in the 
value and press the ‘Go’ button (magnifying glass icon) 
or press Enter.  PCPro displays a range of available 
items, beginning with the value you typed.  For 
example, if you typed Station Port 300, PCPro displays 
a range of ports beginning with port 300.

Previous/Next Use Previous to show settings of the preceding item.
Use Next to show settings of the next item.
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5.5 Data Area

The Data Area is where actual system data appears. The contents of this area are 
specific to what the you are programming. For example, if programming PRG 
10-02, this area shows all the data items within 10-02.

The contents of the Data Area are linked to the various system data views 
available. These are:

 Properties

 Easy Edit

 System Data

5.6 Help Area

The Help Area shows help text relevant for the data in the Data Area. More 
extensive help can usually be found in the application online help (F1 key).

5.7 Status Bar

The status bar, which is a horizontal area at the bottom of the Workspace, 
provides information about the current state of what you are viewing in the 
Workspace and any other contextual information.    

Figure 3-5  PCPro Status Bar

PCPro Account User 
Name And Access Level

Site Name and 
Connection Type

PCPro File 
Version

System Data 
Modification 

Indicator

Description
of Menu Area

Chassis CPU 
Version
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Chapter 4

SL2100

Standard View

SECTION 1 OVERVIEW

Standard View combines system card assignments and information on installed 
extensions, trunks as well as system version information.  

Figure 4-1  Standard View Submenu

This menu displays by right 
clicking on the Standard View 

window.
Window View: Right click to display 
the flyout, which allows you to select 

how you want the Standard 
submenu displayed.

Auto Hide: Clicking this icon hides 
the Standard submenu list and 

docks the tabs on the left side of 
the screen.

Close: Clicking this icon closes 
the Standard submenu list and 

tabs. 
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SECTION 2 STANDARD VIEW SUBMENU

2.1 Accessing Standard View

You can access Standard View submenu area using any of the following 
methods: 

 From the Easy Edit View submenu, select the menu item Cards.

  -- or --

 Select the toolbar icon (by clicking View) depicting the purple cog .

    -- or --

 Press F9.

Once selected, the Standard View menu appears in the Programming submenu 
area. Standard screens are listed alphabetically.   

SECTION 3 CARD CONFIGURATION

The screen represents a conceptual model of the chassis and the card packages 
within it. To obtain blade details download the configuration from the chassis. The 
card slots display the card types (these are the cards that can be inserted in the 
selected slot), the telephone/trunk port range (these are the ports used by the card) 
and firmware version (firmware being used by the blade). By default, all card slots 
are displayed as white indicating no blade has been installed in that slot.

On this screen, you can right mouse click on the desired slot. A popup menu is 
displayed indicating the configurable options for that slot. Once you have selected 
the card that is installed in that slot, the card name is displayed on the front of the slot 
location.

Refer to Figure 4-3 Standard View Card Configuration Screen on page 4-3 for the 
layout of the Card Configuration screen.

Figure 4-2  Selecting a Standard View Screen
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Figure 4-3  Standard View Card Configuration Screen
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3.1 Blade Types

In PCPro, card types are categorized under the following four groups. When you 
right click on the chassis model on the screen, the popup menu is displayed. The 
menu lists the cards and each card type is designated with a distinctive color.   

Telephone
Represented on the Blade Configuration screen as 'blue' cards. Telephone cards 
provide interfaces to telephones being used in the chassis. Telephone cards use 
telephone ports (e.g., a IP7WW-008U-C1 makes use of eight telephone ports).

Trunk
Represented on the Card Configuration screen as 'yellow' blades. Trunk cards 
provide interfaces to lines such as COI or PRI which are being used in the 
chassis. Trunk cards, use trunk ports (e.g., a IP7WW-3COIDB-C1 card makes 
use of three trunk ports).

Combo
Represented on the Card Configuration screen as 'yellow/blue' cards. Trunk cards 
provide interfaces to lines such as digital single line stations, which are being 
used in the chassis. Combo cards, use telephone ports (e.g., a IP7WW-082U-B1 
card makes use of eight digital telephone ports and two analog ports).

3.2 Adding a Card

To add a card, complete the following steps:

1. With the mouse, right click on the slot where you want the card to 
reside.

2. A popup menu appears listing the card types that can be installed.  

3. Select a card type relevant to the card to install.

4. Another popup menu appears listing cards associated with the selected 
card type.

Blade Type and Color

NOTE


There are two additional options on the popup menu. These are 
Configure Card and Delete Card.   These two options are only available 
if a card has previously been added.



Issue 1.0

SL2100 PC Programming Manual 4-5

5. Select the desired card package you want to add.

The slot changes appearances to indicate the card that is installed, the firmware 
version, the port type and the port range that is used.

3.3 Removing a Card

To remove a card, complete the following steps:

1. With the mouse, right click on the card you want to remove.

2. When the popup menu is displayed, select Delete Card.

The card is removed and the slot and port type range it was utilizing is now 
available for use by another card.
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SECTION 4 CLASS OF SERVICE FOR TELEPHONES

This screen combines system data relevant to Class of Service Options for 
telephones.  

Figure 4-4  Standard View Class of Service for Telephones
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The assign Class of Service settings for telephones:

1. For each feature enable or disable each COS (1-15) by clicking the circle for 
the appropriate COS.

2. Enable/Disable telephone-specific feature options for the selected Class of 
Service. These settings are linked with programs 20-07, 20-08, 20-09, 20-10, 
20-11, 20-12 and 20-13.

3. Blue means it is enabled for the selected COS, White means it is disabled.

4. Click Apply to save the settings.

The selected telephones will be members of the class during the selected Night 
Mode. These settings are linked with 20-06.

NOTE


You can select one of three options for viewing the features:  

  Show all features.

      -- or --

  Show only frequently used features.   

You can also choose how you want to view the options:

  Categorized by program       

     -- or --

  Alphabetic (by feature name)  
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SECTION 5 NIGHT MODE SWITCHING

This screen combines system data relevant to the Chassis feature “Night Service”.   

Figure 4-5  Night Service Setup

1)  Enable/Disable 
Automatic Night 
Mode switching.

2)  Assign name to 
each mode.

3)  Specify the mode 
for the time periods 
associate with each 
pattern.

5)  Set which pattern 
each day of the week 
should follow.

The Normalise icon 
will automatically 
assign each day of 
the week to its own 
pattern.

6)  Specify holiday dates 
and which pattern the 
holiday should follow.

4)  Set time pattern 
resolution.
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To setup the Night Mode Switching options:

You can define up to 10 Schedule Patterns for the selected Night Mode Service 
Group. Schedule Patterns is made up of time frames of 1, 15, 20 or 30 minutes. Each 
time frame is associated with a Night Mode. These settings are linked with 12-03.

1. Enable/disable Automatic Night Mode Service.

This selection enables/disables Night Mode Service for the system. This setting 
is linked with 12-01-01. This is a system-wide setting and is applied across ALL 
Service Groups.

2. Assign a name to each Night Mode. This can be used to identify the time frame. 
Night Mode names defined here are referred to throughout the system. These 
settings are linked to 12-07.

3. Define Schedule Patterns used by the selected Night Mode Service Group. 
Schedule Patterns are comprised of time frames that are associated to Night 
Modes. You can define up to 10 Schedule Patterns for the selected Night Mode 
Service Group. Schedule Patterns can be made up of 20 time frames. Each 
time frame is associated with a Night Mode. These settings are linked with 
12-03.

Refer to 5.1 Modifying a Time Frame on page 4-10 and Figure 4-7 Standard 
View Night Mode Switching Mode Colors on page 4-11.

4. Set the time pattern display resolution, options are 1, 15, 20, and 30 minutes.

5. Specify the Service Patterns applied to each day of the week. Define the 
Schedule Pattern used each day of the week by the selected Night Mode 
Service Group. These settings are linked with 12-03.

6. Define public holidays and the Schedule Pattern used by the Night Mode 
Service Group on these days.  Each pattern has a unique color, clicking on the 
date will cycle through all 10 patterns. These settings are linked with 12-04
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5.1 Modifying a Time Frame

This section describes how to add a time frame to a schedule for night mode 
switching.   

 To modify a time frame in a Schedule:

1. Using the mouse select the Grid Resolution time 1, 15, 20, or 30 
minutes.

2. On the left click the color that represents the mode to be assigned.

3. Click the time window for the pattern to be changed.

-- OR --

Left click and drag from the starting time toward the end time. Keep the 
left mouse button pressed while dragging.

4. Release the left mouse button, the time windows selected in step 3 will 
change to the color of the mode selected in step 2.

Figure 4-6  Standard View Night Mode Switching Adding Time Frame

1) Set time pattern 
grid resolution.

2) Click on the color 
that represents the 
mode to be assigned

3) Click on the time 
period to assign the 
selected mode.

4) Set which pattern 
each day of the week 
should follow.

The Normalise icon will 
automatically assign 
each day of the week 
to its own pattern.
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Each mode is assigned a different color. These colors are shown in 
Figure 4-7 Standard View Night Mode Switching Mode Colors.     

Figure 4-7  Standard View Night Mode Switching Mode Colors
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SECTION 6 SYSTEM TIMERS

This screen allows you to set up system-wide timers.  

Figure 4-8  Standard View System Timers

Make necessary 
changes to the timers.
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The settings that can be changed on this screen include the individual timers. The 
timers can be displayed in program order (Default), ascending or descending 
alphabetical order by clicking on the time name column.

To change the timer settings from the default:

1. Click the value to the right of the time you want to change.

2. Change the timer setting and click Apply.
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SECTION 7 SYSTEM TIMER CLASSES

This screen combines system data relevant to Timer Classes. Timer Classes detail 
timers for each class 1-15. Extensions can then be assigned as members of these 
classes for each of the system Night Modes in Program 20-29. Trunks can then be 
assigned as members of these classes for each of the system Night Modes in 
program 20-30.   

The settings that can be changed on this screen include:

 Time Class: The Timer Class to which timers are assigned.

 Night Mode: The Night Mode assigned for night mode switching.

 Timers: The system wide timers that can be changed.

 Trunks/Telephone: Lists the trunks/telephones that are members of the class 
during the selected Night Mode.

 Extensions: Lists the extensions that are members of the class during the 
selected Night Mode.

Figure 4-9  Standard View System Timer Classes
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Chapter 5

SL2100

Easy Edit

SECTION 1 OVERVIEW

Easy Edit is a system programming feature where system settings are grouped 
together by feature or equipment type. This allows commonly changed system 
settings to be quickly accessed and programmed when configuring a system.  

Figure 5-1  Easy Edit Submenu

Window View: Clicking this icon 
displays the flyout, which allows you 

to select how you want the Easy 
Edit submenu displayed.  Right 

mouse clicking also displays this 
menu.

Auto Hide: Clicking this icon hides 
the Easy Edit submenu list and 

docks the tabs on the left side of 
the screen.

Close: Clicking this icon closes 
the Easy Edit submenu list and 

tabs. 
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SECTION 2 ACCESSING EASY EDIT VIEW

To access Easy Edit View complete one of the following:

 Select View Tab > Easy Edit.

   -- or --

 Press F12.

   -- or --

 If the Easy Edit submenu area is currently open, select the Easy Edit tab 
depicting the magic wand, located at the bottom on the submenu.  

Easy Edit is a system programming feature where system settings are grouped 
together by feature or equipment type. This allows commonly changed system 
settings to be quickly accessed and programmed when configuring a system.

SECTION 3 SEARCHING FOR A FEATURE

You can use the search function of Easy Edit to locate a specific feature or use a 
keyword to find a group of related features. The example below shows entering the 
exact feature name to locate the feature and entering a keyword to locate a group of 
similar features. Start the search by either pressing the magnifying glass icon or 
pressing Enter.   
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SECTION 4 PROGRAMMING LEVELS

There are three levels in which feature programming is grouped.  You can apply 
program filters to system data programming:

 Level 1 – are the most commonly assigned programs for a feature.

 Level 2 – are the next most commonly assigned programs for a feature.

 Level 3 – are programs that are not often assigned for a particular feature and 
require an expert level working knowledge of the system to be properly 
assigned.

To show the level of programming for a feature:

1. Press the desired level to view the programs assigned at that level.

2. Select a feature.  

Level 1 Level 2 Level 3
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SECTION 5 USING EASY EDIT

Easy Edit is a system programming feature where system settings are grouped 
together by feature or equipment type. This allows commonly changed system 
settings to be quickly accessed and programmed when configuring a system.  

Figure 5-2  Easy Edit Tab

The programming level 
options are used to filter 
the displayed programs 
according to the level 1, 
2 or 3 option.

Easy Edit programs are grouped 
according to features, extension 
or trunk types.
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5.1 Filter Bar

Filtering adds the ability to filter an easy edit page on any settable value for the 
selected column. Clicking on the Filter Bar icon will enable this feature.  

After the filter bar is displayed any value can be entered as a filter for a column. In 
the example below, the station name column was filtered for “10”, so any name 
that contains 10 will be shown. You can filter multiple columns for different values 
as needed.

Once in the Column array, data can be grouped using the Group Bar. To return 
the page back to default click on the “Default” icon.  

Figure 5-3  Filter Bar

Figure 5-4  Column Filter Example
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5.2 Group By

The Group By option adds the ability to sort displayed data on an easy edit page 
by any of the setting options for that page, or by any settable value for the 
selected column. Clicking on the Group by icon will enable this feature.    

To set group by options, simply click on the Group By option. Then drag a column 
heading into the group by area to use that as a grouping option. Grouping options 
are set as priority in the order they were added. In the example below, the 
grouping is first done by Message Waiting Lamp LED Color, then by Extension 
number. Grouping can be done as needed in any order and by as many options 
as there are columns on a particular page.

The Expand All and Contract All features are used to expand or contract all 
grouping.

Once grouped, data can be filtered using the Filter Bar. To return the page back to 
default, simply click on the “Default” icon.   

Figure 5-5  Group By Option

Figure 5-6  Group By Internal Paging Group Example
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5.3 Column Chooser

The Column Chooser allows the customization of pages to display only the 
desired columns. Clicking the Column Chooser icon will bring up a window to 
which columns can be dragged in and out of. To remove a column, click the 
heading and drag it to the Column Chooser window. To add a column click the 
heading and drag it into the Column array area.

Once in the Column array area columns can be filtered using the Filter Bar or 
grouped using the Group Bar. Columns can also be moved as needed by clicking 
and holding the column title then dragging it to the desired position. The order of a 
column can be changed from high to low or low to high. For instance, the 
extension column can start with extension 101 at the top or with extension 3961. 
To change the order click on the column title box, an arrow will appear in that box 
that when clicked will change to sort order for that column.

To return the page back to default simply click on the “Default” icon.  

Figure 5-7  Column Chooser Example
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5.4 Save State

Once modified, Easy Edit pages can be saved so the same options are displayed 
each time that page is opened. The current view state of the Easy Edit page as 
set is saved and is displayed each time you enter the page. You must also save 
the database to retain this setting on exit. To return the page back to default click 
on the “Default” icon and choose to Save State again.   

Settings remembered:

• Column Chooser

• Group By

• Filter Bar enabled or disabled

• Column width

• Column order

Settings not remembered:

• Filter strings

Figure 5-8  Save State Example
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5.5 Grid Style and Custom Themes

The Grid style is used to select a predefined theme, create a custom theme, or 
edit an existing theme. This allows the simple selection of six color themes or to 
make your own theme and save to six custom slots.

A total of six predefined themes or six custom themes can be created. There are 
many color and gradient options for the grid including color/gradient attributes for 
each grid area such as odd/even rows, groups, header, selection and others. 
These can be used to select the preferred scheme.  

Any aspect provided by the grid theme can be changed using the ‘Theme edit’ 
panel. First select the Item from the dropdown list. Either the color picker will 
enable or the gradient spin control.

There are no less than 46 different areas that a color or gradient can be chosen 
for on the grid.

• Selected cell colors

• Odd and even row colors

• Header

• Grid lines

• Background

• Left offset

Selected header colors Each with a setting for:

• Background

• Text

• Border

Figure 5-9  Grid Style Example
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• Gradient color

• Gradient angle

• Grid Lines or no grid lines.

The range of colors follows the colors supported by the user’s PC.   

The initial box contains 125 colors and 25 grays, but clicking the ‘Other colors’ 
button will bring up the color picker from which the user can even use the ‘Select’ 
pipette and touch anywhere on their screen to pick up the color.  

Figure 5-10  Color Selection Example

Figure 5-11  Choosing the Color Picker
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To save a custom theme, choose one of the undefined themes, make changes as 
desired, then check the “Save Custom” box when finished. A predefined theme 
can be changed and by checking the “Save Custom” will over-write the default 
settings for the selected theme.  

Figure 5-12  Saving a Custom Theme
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Chapter 6

SL2100

Initial Setup Wizard

SECTION 1 OVERVIEW

Easy Edit is an alternative system programming feature within PC Pro which can be 
used in place of or in conjunction with System Data commands. Where the System 
Data view groups commands by command number, Easy Edit groups commands by 
function. In some cases grouping several commands onto a single screen. Refer to 
Chapter 5 Easy Edit for more information.

Easy Edit also includes an Initial Setup Wizard that can be used with new 
installations to setup basic functionality. This can only be used on a default system.  
The following sections include instructions on defaulting the SL2100 and using the 
Initial Setup Wizard.

Opening Easy Edit

The Easy Edit menus can be accessed by:

 Selecting View > Easy Edit from top menu bar

 Clicking on the EasyEdit icon on the Toolbar.

 From the tab at the lower right corner.

 Press F12.
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SECTION 2 INITIAL SETUP WIZARD

The Initial Setup Wizard is only used for a new installation, after the system has been 
factory defaulted, to setup the numbering plan and trunks. Once the database has 
been modified, the Initial Setup Wizard can no longer be used.

1. Factory default the SL2100 CPU by holding in the Load button and turning On
the power (refer to Figure 6-2 Load Button on page 6-3). Keep the Load button
pressed until the green Run lamp illuminates.

Figure 6-1  PCPro View Tab
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2. Select Initial Setup Wizard from the Easy Edit menu.

3. Click the Connect to the system and enter user name and password 
button.  

Figure 6-2  Load Button

Figure 6-3  Connect to System
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4. In the Connection Account window enter the IP Address of the SL2100, the 
User Name, and the Password.

 IP Address: The default IP addresses of the SL2100 are:

 Ethernet Connector – 192.168.0.10

 VoIP Connector – 172.168.0.10

Also, from a multiline (digital) phone, press Menu – 96 – Select to view the 
current IP addresses.

 User Name: Tech

 Password: 12345678

5. Select Initial Setup Wizard again, then click the Download configuration then 
click “Start setup” button.  

6. In the Download window, verify that Select All (refer to Figure 6-5 Download 
Screen on page 6-5) is checked, then click Start.

Figure 6-4  Download Configuration
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7. When “Download Complete” is displayed, click Close.       

Figure 6-5  Download Screen

Figure 6-6  Download Complete Notification

NOTE


If there is an error stating that the database is not default, then the Factory 
Default from Step 1 has not been performed.
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8. Click the Start setup button.   

9. Select your North American Region.  

10. Select your Time Zone.  

Figure 6-7  Start Setup Screen

Figure 6-8  Regions

Figure 6-9  Time Zones
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11. Select the Extension number range.

If the defaults, 101-199, are to be kept then select “No change to default”. If 
1xxx, 2xxx, or 3xxx is selected, additional selections will be required.   

If the Extension Start Range of 1xxx, 2xxx, or 3xxx was selected in the previous 
step, click on the specific extension range to be used. Or choose “Back” to 
make no choice and return to the previous screen.   

Figure 6-10  Extension Start Range

Figure 6-11  Extension Range Starting with 1
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12. Select an option to change the default Service Codes or to keep the default 
values.   

Why should the Service Codes be changed?

One example is if the local Area Code matches a Service Code, such as 718 
(Night Mode Switching), then to prevent the users from accidentally dialing the 
Service Code it can be changed to 718.   

13. Select the Key Assignment for use with trunks. “Line” keys are typically used for 
Analog (C.O.) trunks or if there are fewer than 12 SIP trunks. “Loop” & “Park” 
keys are typically used for ISDN trunks and if there are more than 12 SIP 
trunks.   

NOTE
 For most installations the Service Codes will remain default.

Figure 6-12  Service Codes Screen

Figure 6-13  Key Assignment Screen
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14. The Initial Setup Wizard will auto detect installed ISDN or Analog (C.O.) trunk 
cards and prompt for their configuration. If no trunk cards are detected, such as 
if SIP trunks are to be used, then choose No Trunk cards detected.       

To configure Analog trunks, continue with section 2.1Analog (C.O.) Trunks.

For ISDN PRI trunks, proceed to section 2.2 ISDN PRI Trunks on page 6-13.

For SIP trunks, proceed to section 2.3 SIP Trunks on page 6-18.

2.1 Analog (C.O.) Trunks

The Analog Trunks configuration screen sets the destination of incoming calls on 
each trunk for both Day Mode (mode 1) and Night Mode (mode 2). Each “mode” 
has two columns, T1 and T2 (Target 1 and Target 2). The incoming call first lands 
on the T1 destination, then after the timer (green button) expires, it overflows to 
the T2 destination.

Each Analog trunk is displayed in top-down order, with Analog trunk 1 on the top 
most row. Clicking on the red sphere button (refer to Figure 6-15 Trunks Screen 
on page 6-10) will open the Trunk Properties window for the selected trunk.

NOTE


❍ If SIP Trunks and Analog Trunks are to both be installed, select “Analog 
Trunks”. The SIP Trunk selection will appear later in the Setup Wizard.

❍ If SIP Trunks and ISDN Trunks are to both be installed, select “Primary 
rate (ISDN24)”. The SIP Trunk selection will appear later in the Setup 
Wizard.

Figure 6-14  Detected Trunk Type
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The buttons under the T1 and T2 columns are toggles. Clicking on them will 
toggle between Ring Group 1, Ring Group 2, Ring Group 3, Ring Group 4 or Auto 
Attendant. The T2 column also has a Not Set option.   

Figure 6-15  Trunks Screen

Table 6-1  Button Descriptions 

Button Description

Timer for how long the call rings at the T1 destination before 
forwarding to the T2 destination. Click this button to toggle through 
the times (0, 5, 8, 10, 15, 20, or 30 seconds)

This button opens the Trunk Properties window for the selected 
trunk.

Day and Night mode buttons to assign Ring Group 1 as the 
destination.

Day and Night mode buttons to assign Ring Group 2 as the 
destination.
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Day and Night mode buttons to assign Ring Group 3 as the 
destination.

Day and Night mode buttons to assign Ring Group 4 as the 
destination.

Day and Night mode buttons to assign InMail as the destination. The 
default InMail settings will send the call to the first Auto Attendant.

Day and Night mode buttons to assign no destination. This is only 
applicable to the T2 column.

Apply button.

Table 6-1  Button Descriptions  (Continued)

Button Description
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When a Ring Group is selected, the Properties window for that Ring Group will 
display so that extensions can be added or removed. To add or remove an 
extension, click in the field to the right of the Member number. Click the Apply 
button to save the change.  

Figure 6-16  Example of Trunk Properties Screen
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When Voicemail is selected, the Properties window for voicemail will display. This 
property window applies to all trunks for both Day and Night mode.   

When finished, click the blue arrow at the bottom to continue with the Initial Setup 
Wizard. Proceed to section 2.4 Completing the Initial Setup Wizard on page 6-23.

2.2 ISDN PRI Trunks

1. Click the Trunks to DID button to continue.  

Figure 6-17  Example of Voicemail Properties Screen

Figure 6-18  Trunk Routing Type Screen
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2. Select the number of DID blocks that are required.
For less than 50 DID’s, choose “50 DID Blocks”.
For more than 50 DID’s, choose “100 DID Blocks”.
If unsure, choose “100 DID Blocks”.  

Tech Note

The numbers shown on the buttons indicate the DID Translation Table Entries 
used for Day/Common and Night. “Common” means that a DID will ring the same 
destination 24 hours a day.   

For each Mode there are two sets of numbers. In the button above we have:

 Day Mode:  1-50 and 0-0 (0-0 = no setting)

 Night Mode:  51-100 and 1-50

For example, using the button above, DID 3101 should ring extension 101 during 
the Day and at Night go to the Auto Attendant. DID 3102 should ring extension 
102 in Day or at Night. Both 3101 and 3102 are assigned to Day Mode (1-50). 
3101 is also assigned to Night Mode (51-100).

During Day Mode the system will look for a DID match from 1-50. Both numbers 
are there so a match is found.

In Night Mode, the system will first look for a match from 51-100. It will find 3101 
and direct the call to the Auto Attendant. It doesn’t find 3102 so will next look from 
1-50 for a match, which it finds, and 3102 goes to the same destination as it does 
during Day Mode.

3. Click the Add Range button (refer to Figure 6-21 Add Range Screen on 
page 6-15) to configure incoming DID’s. This button can be clicked multiple 
times, for example once for Day Mode and again for Night Mode.

Figure 6-19  DID Routing Screen

Figure 6-20  Example of DID Matches
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4. Another window will open where you can enter the Received DID digits 
(enter the last four digits) and where you want the DID to go (Target). If 
there are multiple DID’s which are in consecutive sequential order and are 
going to Target’s which are also in consecutive sequential order, then enter 
the first DID and first Target and set the Count field to the number of DID’s. 
The system will automatically assign the range of DID’s.

The buttons at the bottom of the window are the system Operation 
Modes. Select the Mode which the DID or DID range will operate.      

Figure 6-21  Add Range Screen

NOTE


If the DID is going to the same location 24 hours a day, choose the 
Day button. If the system will not use Night Mode, choose the Day 
button.

Figure 6-22  DID Add Range
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Examples:

Mode 1 “Day”
During the Day, incoming DID’s 214-555-3101 through 214-555-3110 should ring 
at extension 101 through 110 respectively (meaning 214-555-3101 goes to 101, 
214-555-3102 goes to 102, etc.). If not answered, the call should overflow to the 
specific extensions voicemail box.

Mode 2 “Night” Option 1
At Night, incoming DID’s 214-555-3101 through 214-555-3110 should go directly 
to the voicemail box for 101 through 110 respectively.

Mode 2 “Night” Option 2
At Night, incoming DID’s 214-555-3101 through 214-555-3110 will all go directly 
to the Auto Attendant.   

Figure 6-23  Mode 1 – Mode 2 Options
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5. If SIP trunks need to be configured continue with section 2.3 SIP Trunks on 
page 6-18 to add SIP trunks.  If all DID’s have been added, click Next and 
proceed to section 2.4 Completing the Initial Setup Wizard on page 6-23 to 
complete the Initial Setup Wizard.  

Figure 6-24  Add Range – Next Button
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2.3 SIP Trunks

1. Click Add SIP button to continue.   

2. Click Enable SIP trunks button.   

3. Select the number of SIP trunks required.  

Figure 6-25  Add SIP Button

Figure 6-26  Enable SIP Trunks Button

Figure 6-27  Enable SIP Trunks Button
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4. Select the SIP carrier configuration type.   

5. Select the number of DID blocks that are required.
For less than 50 DID’s, choose “50 DID Blocks”.
For more than 50 DID’s, choose “100 DID Blocks”.
If unsure, choose “100 DID Blocks”.  

Tech Note

The numbers shown on the buttons indicate the DID Translation Table Entries 
used for Day/Common and Night. “Common” means that a DID will ring the same 
destination 24 hours a day.   

For each Mode there are two sets of numbers. In the button above we have:

 Day Mode:  1-50 and 0-0 (0-0 = no setting)

 Night Mode:  51-100 and 1-50

Figure 6-28  SIP Carrier Configuration Type

Figure 6-29  DID Routing Screen

Figure 6-30  Example of DID Matches
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For example, using the button above, DID 3101 should ring extension 101 during 
the Day and at Night go to the Auto Attendant. DID 3102 should ring extension 
102 in Day or at Night. Both 3101 and 3102 are assigned to Day Mode (1-50). 
3101 is also assigned to Night Mode (51-100).

During Day Mode the system will look for a DID match from 1-50. Both numbers 
are there so a match is found.

In Night Mode, the system will first look for a match from 51-100. It will find 3101 
and direct the call to the Auto Attendant. It doesn’t find 3102 so will next look from 
1-50 for a match, which it finds, and 3102 goes to the same destination as it does 
during Day Mode.

6. Click the Add Range button to configure incoming DID’s. This button can be 
clicked multiple times, for example once for Day Mode and again for Night 
Mode.  

7. Another window will open where you can enter the Received DID digits 
(enter the last four digits) and where you want the DID to go (Target). If 
there are multiple DID’s which are in consecutive sequential order and are 
going to Target’s which are also in consecutive sequential order, then enter 
the first DID and first Target and set the Count field to the number of DID’s. 
The system will automatically assign the range of DID’s.

The buttons at the bottom of the window are the system Operation 
Modes. Select the Mode which the DID or DID range will operate.      

Figure 6-31  Add Range Screen

NOTE


If the DID is going to the same location 24 hours a day, choose the 
Day button. If the system will not use Night Mode, choose the Day 
button.
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Examples:

Mode 1 “Day”
During the Day, incoming DID’s 214-555-3101 through 214-555-3110 should ring 
at extension 101 through 110 respectively (meaning 214-555-3101 goes to 101, 
214-555-3102 goes to 102, etc.). If not answered, the call should overflow to the 
specific extensions voicemail box.

Mode 2 “Night” Option 1
At Night, incoming DID’s 214-555-3101 through 214-555-3110 should go directly 
to the voicemail box for 101 through 110 respectively.

Mode 2 “Night” Option 2
At Night, incoming DID’s 214-555-3101 through 214-555-3110 will all go directly 
to the Auto Attendant.   

Figure 6-32  DID Add Range

Figure 6-33  Mode 1 – Mode 2 Options
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8. After all DID’s have been added, click Next.   

9. Continue to section 2.4 Completing the Initial Setup Wizard on page 6-23 to 
complete the Initial Setup Wizard.

Figure 6-34  Add Range – Next Button
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2.4 Completing the Initial Setup Wizard

1. Select the Set Time and Date button.   

2. The System Time Settings window will appear and will have pulled the 
current Date and Time from the computer running PcPro. Click OK to set it 
to the SL2100.  

Figure 6-35  Time and Date Button

Figure 6-36  System Time Settings Screen
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3. Click the Upload, modified items button.   

4. In the upload window, click the red box with the red arrow, then click Start to 
upload the database changes.   

Figure 6-37  Upload, Modified Items Screen

Figure 6-38  Upload Database Changes
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5. When “Operation complete” is displayed, click Close.   

6. Click the Disconnect button to disconnect from the SL2100.   

7. Save a copy of the database by choosing File and Save As, giving each 
site a descriptive file name.  

If needed, future program changes can be made using Easy Edit or System Data 
options in PC Pro for the database saved in step 7 above.

Figure 6-39  Operation Complete Notification

Figure 6-40  Disconnect Screen

Figure 6-41  Save As
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Chapter 7

SL2100

System Data View

SECTION 1 OVERVIEW

System Data represent systems settings as per the categorization used by main 
software. This categorization separates settings into System Data items called 
‘PRGs’ (programs). PRGs are identified by their ID and name. The ID and name 
indicate what settings the System Data is related to. An example of a PRG identifier 
can be seen below, ‘10-02’ is the ID and ‘Location Setup’ is the name:

10-02: Location Setup

PRGs are grouped by their relationship into ‘PRG Groups’. PRG Groups are 
identified by their ID and name. The ID and Name indicate what settings the System 
Data is related to. An example of a PRG identifier can be seen below, ‘10-XX’ is the 
ID and ‘System Configuration’ is the name:

10-XX: System Configuration

Since System Data Programming does not group together the programs for a 
function/feature as with Easy Edit and Standard screens, System Data Programming 
is intended for advanced users of PCPro who are very familiar with programming a 
system. 
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Figure 7-1  System Data Submenu

Auto Hide: Clicking this icon hides 
the System Data submenu list and 
docks the tabs on the left side of 

the screen.

Close: Clicking this icon closes 
the System Data submenu list 

and tabs. 
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SECTION 2 ACCESSING SYSTEM DATA VIEW

To access System Data View, complete one of the following:

 Select the menu item View > System Data.

   -- or --

 Select the toolbar icon depicting the blue block .

   -- or --

 Press F11.

   -- or --

 If the Programming submenu area is currently open, select the System Data tab 
depicting the blue box, located at the bottom on the submenu.    

The System Data View Menu appears in the submenu area. System Data is grouped 
by PRG Groups and ordered numerically by ID. You can use the Expand All to view 
all of the items under each Program Number or Collapse All to return to the numeric 
program listing. You can individually expand or collapse a program number pressing 

or .
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SECTION 3 SEARCHING FOR A PROGRAM

You can use the search function of Program Data to locate a specific program or use 
a keyword to find a group of related programs. The example below shows entering a 
program number to locate a specific program and entering a keyword to locate a 
group of similar programs. Start the search by either pressing the magnifying glass 
icon or pressing Enter.   

SECTION 4 SYSTEM DATA PROGRAM FILTERING

When selecting programs from the system data list, you can select from the following 
filters:

  – shows all system data.

  – shows only unsaved system data.

  – show only system data that needs to be uploaded.

  – shows only system data that is unsaved and needs to be uploaded.
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To show the level of programming for a feature:

1. Select a program.

2. Press the desired filter and view the filtered programs.  

SECTION 5 USING SYSTEM DATA

System Data screens are intended for advanced users who are very familiar with 
using PCPro. If you are not familiar with PCPro, you should use either the Standard 
View or Easy Edit. Standard View and Easy Edit are grouped together to help guide 
you through system data necessary for programming various features of the system. 

Filter 2 Filter 3 Filter 4Filter 1

Figure 7-2  System Data Programming

1)  Select system 
data.

Filter

View Next 
item. 

View Previous 
item. 

Pull down menu to 
changed system data 
item being viewed. 

Mouse over for 
help information.

2)  Modify system 
data items.
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To modify system data:

1. Select a PRG from the System Data View submenu.

2. Modify the desired settings on the screen.

3. Press the Apply button to save the changes.

When programming system data, changes are applied:

 when the Apply button is pressed.

 when the you change the system data item link.

 when you modify the current system data item filter.

 when you exit System Data View, except when the Cancel button is pressed.
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Chapter 8

SL2100

Menu and Toolbar Reference

SECTION 1 OVERVIEW

This chapter provides a table that can be used as a reference between the menus, 
toolbar icons and keyboard shortcuts. Most functions have more than one method for 
accessing it. Any sub-menus are listed with their associated menu.

SECTION 2 MENUS AND TOOLBARS

The menu (located at the top of the screen) allows access to a list of functions 
provided by PCPro. The toolbar provides a graphical icon interface to some of the 
more commonly used functions.  

Figure 8-1  Menu and Toolbar

Menu (default)

Toolbar
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Table 8-1 Menus lists the menu options, provides a brief description of the menu and 
shows an graphical representation of the menu display. Some menu items have a 
flyout, indicated by the , which provides additional options for that selection.   

Table 8-1  Menus 

Menu Description Menu Display

File This menu provides access to:
 functions related to creating 

and saving files

 sending an e-mail with an 
active configuration attached

 displaying the properties for 
an active configuration

 allowing users to log off and 
log in as a different user

 exiting PCPro

View This menu allows you to:
 show/hide the Toolbar

 show/hide the Status Bar

 show/hide the Tool Tips

 show/hide the Submenu Area

Home This menu provides access to:
 Connect/Disconnect to PCPro

 Upload/Download files

 View/edit blade configurations

 Set the system time

 Make multiple assignments 
for Account Codes, 
Extensions, DID and Function 
Keys

 Run Scripts

 Configure PCPro Accounts

 PCPro configuration settings

 Create software files

 Upgrade software files

 Feature activation

 Verify
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Reports This menu allows you to 
various reports on system 
settings:
 Class of Service settings

 Alarm status

 History of modifications

 Non default values settings

 Numbering Plan settings

 System configuration settings

 System Data settings

 Feature Activation

 VSlot

 Import DID Tables and Speed 
Dial numbers

 Export DID Tables, Speed 
Dial numbers and DESI 
Labels

Filter This menu allows you to filter 
by:
 IP Phone list

 Mobile Extension list

 Unused Phone list

 Unused Trunk list

 Filter by Extension

 Filter by Trunk

Tools This menu provides access to:
 Initialize the System

 Launch the Debug Terminal

 DIM File download

 RTP information

 Auto database download

Help This  menu provides access to:
 Display the application 

version, the version and 
copyright date for the main 
software to which PCPro is 
connected

Table 8-1  Menus  (Continued)

Menu Description Menu Display
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Table 8-2 Menu/Toolbar Hierarchy and Keyboard Shortcut Cross-Reference 
provides a list of the main menu items listed on the menu bar. Any associated 
sub-menus are listed in the Sub-menu Level 1, Sub-menu Level 2 and Sub-menu 
Level 3 columns. If a toolbar icon or shortcut key is available for the menu item, it is 
listed in the Toolbar Icon and Shortcut Key Sequence columns.  

Table 8-2  Menu/Toolbar Hierarchy and Keyboard Shortcut Cross-Reference 

Main Menu Item
Sub-menu Level 

1 Item
Sub-menu Level 2 

Item
Sub-menu Level 3 

Item
Toolbar

Icon

Shortcut 
Key 

Sequence

File New SL2100 North America SL2100 V1.0
Ctrl + N

Open…
Ctrl + O

Save
Ctrl + S

Save As…

Send

Properties

Log off

Exit
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Table 8-3  Toolbar Menus and Sub-Toolbar Menus

Home

Communications Programming Multi Assign Scripts Accounts Maintenance

Disconnect Cards (Blades)

Multi 
Assign

Account Code

Run 
Scripts

PCPro 
Accounts

Create Software File

Connect Time setting PCPro 
Configuration

Upgrade Software

Upload DID Feature Activation

Download Extension 
Number

Verify

Function Key

View

View General System Data

System data Tool Bar Tool tips Display (5-10-20-30)

Standard Status Bar

Navigation

Report

Reports Import Export

Class of service DID table DID tables

Alarms Speed dial Speed dials

Modification 
History

DESI Labels

Non default values

Numbering plan

System 
Configuration

System data

Feature activation

VSlot

Filter 
Options

Unregistered Phones Unregistered Trunks Filters

IP Phone list Unused trunk list Extension

Mobile Extension list Trunks

Unused phone list
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Tools

System

System initialize

Debug terminal

DIM file download
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Appendix A

SL2100

MultiAssign

SECTION 1 OVERVIEW

To shorten the time needed to program certain system data, PCPro provides a series 
of special purpose dialogs. These dialogs enable you to set multiple values with 
ease.

SECTION 2 ACCESSING MULTIASSIGN DIALOGS

To access the various dialogs available for the MultiAssign option, select Home > 
MultiAssign from the toolbar (refer to Figure A-1 Accessing the MultiAssign 
Dialogs). Select the desired option for assigning:

 Account Codes

 Extension Numbers

 Direct Inward Dialing

 Function Keys

Figure A-1  Accessing the MultiAssign Dialogs
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SECTION 3 ASSIGNING ACCOUNT CODES

The Account Codes multi-assignment dialog enables the user to set a range of 
account codes. This saves valuable time over having to enter each account code 
individually.

The Account Codes dialog box is accessed by selecting Home > MultiAssign > 
Account Codes from the toolbar.   

To assign a range of account code BINs with numbers:

1. Specify the begin/end BIN range over which to iterate.

2. Specify the account code number to being the assignment.

3. Specify by how much each account code is to be incremented. For example, a 
value of 2 means accounts codes will increment by 2 for each BIN (i.e. 0001, 
0003, 0005…).

4. Click the Apply button to trigger the assignment.

Figure A-2  MultiAssign Account Codes

1)  Specify 
Account Code 
BIN range.

2)  Specify Account
Code number with 
which to begin 
assignment.

3)  Specify the 
number indicating 
how much to 
increment each 
Account Code.

4)  Click Apply to assign the 
specified Account Codes.
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Example

To assign BINs 001 ~ 010 with account codes 00001 ~ 00019 in increments of 2:

1. Place a 1 in the Begin at Verified Account Code Bin edit box.

2. Place a 10 in the End at Verified Account Code Bin edit box.

3. Place 00001 in the Begin the assignment use the Account Code edit box.

4. Place 2 in the Increment Account Codes by edit box.

5. Click Apply.

The result will be…

BIN 001 = 00001
BIN 002 = 00003
BIN 003 = 00005
…
BIN 010 = 00019
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SECTION 4 ASSIGNING DIRECT INWARD DIAL (DID) NUMBERS

DID allows you to assign multiple DID table entries.

The dialog is found under the menu item Programming > MultiAssign > Direct 
Inward Dial (DID).  

To assign DID entries:

1. Enter the DID Translation Table Entry number to begin the assignment.

2. Specify the number of indials.

3. Enter the starting Received Number.

4. Specify either Extension or Dial number by clicking the associated button.

5. Use the pulldown menu to select the appropriate Target Number.

6. Click the Apply button to trigger the assignments.

Figure A-3  MultiAssign Direct Inward Dialing (DID)

1)  Enter the 
DID Translation 
Table number.

6)  Click Apply 
to trigger the 
assignments.

2)  Specify the 
number of indials.

3)  Enter the starting 
Received Number.

5)  Select the starting 
Target Number.

4)  Click either 
Extension or Dial 
number.
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SECTION 5 ASSIGNING EXTENSION NUMBERS

The Extension Number multi-assignment dialog enables you to set a range of 
extension numbers to ports. This saves valuable time over having to enter each 
extension number individually. In addition, the dialog allows you to set blank 
extensions, thus providing a convenient way of freeing extension numbers for use by 
other ports.

The dialog is found under the menu item Home > Multi-assign > Extension 
Numbers.   

Figure A-4  MultiAssignment Extension Numbers

1)  Select 
extension type.

2)  Specify beginning 
and ending port 
numbers in the range.

4)  Click Apply 
to trigger the 
assignments.

3)  Enter the extension 
number used to begin 
assignment (or leave 
blank to clear numbers).
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To assign a group of ports with extension numbers:

1. Select the type of extensions you want to apply.

2. Specify the port range over which to iterate.

3. Specify the extension number to begin the assignment. (Leave this field blank 
to clear the extension numbers).

4. Click the Apply button to trigger the assignment.

Example

To assign telephone ports 001~099 with extension numbers 301~399:

1. To assign station numbers select 11-01: Extension Numbering as our extension
type.

2. Place a 1 in the Begin at Station Port edit box.

3. Place a 99 in the End at Station Port edit box.

4. Place 301 in the Begin the assignment use the extension edit box.

5. Click Apply.

The result is…
Port 001 = Ext 301
Port 002 = 302
Port 003 = 303
…
Port 099 = 399

SECTION 6 ASSIGNING FUNCTION KEYS

The Function Keys multi-assignment dialog enables you to setup a group of function 
keys for individual or multiple telephones. The dialog is best used if you need to set 
up many telephones to have the same set of function keys. The function layout can 
also be saved as a template to use when needed.

NOTE


The extension numbers must validate against the numbering plan setup in 
PRG-11-01. In addition, duplicate extension numbers cannot exist. In this case, 
free the extension numbers by assigning a blank to the ports using those 
extension numbers.
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From the main menu choose Home > Multi-assign > Function key.  

From Quick Install choose Extensions > Function Key Template.   

Figure A-5  MultiAssignment Function Keys

Figure A-6  Function Key Template Selection
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Once on the Key Template page the pull down menu will show a list of extensions. 
When “Show all ports” is enabled every extension the system is capable of 
supporting is shown. If disabled, only extensions that are actually installed in the 
system are displayed. The default for this option is enabled.

When “Show all keys” is enabled, function keys 1~48 are shown. If disabled, only 
function keys 1~24 are shown. The default for this option is enabled.   

Figure A-7  List of Extensions
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Once the extension has been selected, click on the Edit Keys tab and assign the 
Function Keys. To assign a key choose the feature to assign to a key, then click on 
the key to be assigned. In cases where additional options must first be selected, a 
menu will be displayed showing the option. The example below shows the options 
when assigning Hybrid/Loop keys.

Here you see that Hybrid/Loop key was selected from the function key options, in the 
Choice box Both (2) was selected, then line key one was clicked on. At that point line 
key one is selected. You can continue to click on subsequent function keys until the 
desired Hybrid/Loop keys have been assigned.   

Figure A-8  Assigning Hybrid/Loop Keys
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You can also choose to assign an entire row with Hybrid/Loop keys by right clicking 
on a function key and choosing “Fill a Row”. PC Pro will start on which ever line key 
you select and fill to the end of that row. For this example a default extension will 
have the top row assigned as Hybrid/Loop keys and the second row will be 
unassigned.   

Figure A-9  Fill a Row Example
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After selecting a Hybrid/Loop Key, the first line is right clicked. Then Fill a Row is 
selected.   

Figure A-10  Fill a Row Example
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The first row has now been assigned. Next the “none” option was selected, line key 7 
was right clicked on, and “Fill a Row” was chosen from the displayed options.  

Using the Apply Multiple Tab you can copy the line key settings from the selected 
extension to other extensions.   

Figure A-11  Fill a Row Example

Figure A-12  Apply Multiple 
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SECTION 7 SAVING A FUNCTION KEY TEMPLATE

PC Pro allows an extension’s function key configuration to be saved as a template to 
be used later. To save a configuration as a template go to Easy Edit choose Basic 
Setup > Extensions > Key Assignment > Function Key Template. Once there, 
you can choose the extension to be used as the template from the pull down menu.  

Next click on the “Save As” icon, browse to the location on the support PC to store 
the template file, name the file and click Save.  

Figure A-13  Saving a Function Key Template

Figure A-14  Saving a Function Key Template
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SECTION 8 OPENING A SAVED FUNCTION KEY TEMPLATE

PC Pro allows an extension’s function key configuration to be saved as a template to 
be used later. To open a saved configuration template, go to Easy Edit choose 
Basic Setup > Extensions > Key Assignment > Function Key Template. Once 
there, click on the Open icon.  

Next browse to the location on the support PC where the template file is stored, 
select the file and click Open.  

Figure A-15  Opening a Saved Function Key Template

Figure A-16  Opening a Saved Function Key Template
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Appendix B

SL2100

Communications

SECTION 1 OVERVIEW

PCPro provides methods for the application to communicate with the chassis.  
PCPro can connect to the chassis to allow you to download/upload data, to perform a 
system initialization, to update firmware, to activate features and to backup a 
database to or restore a database from a flash key.

SECTION 2 CONNECT/DISCONNECT

Connect/Disconnect makes or breaks a connection session between PCPro and a 
chassis. This option changes its functionality depending on the connection status of 
PCPro.  Figure B-1 Connect/Disconnect Status shows how the connection status is 
indicated on the toolbar.   

Figure B-1  Connect/Disconnect Status

Disconnected Signifies that PCPro is not connected to the chassis.

Connected Signifies that PCPro is currently connected to the chassis.

Connect/Disconnect Status
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2.1 Accessing Connection Dialog

Connecting PCPro to a system is done within the Connect dialog. While PCPro is 
disconnected from a system, access the Connect dialog using one of the following 
three methods.

 Select the menu item Home:Communications > Connect/Disconnect.

    -- or --

 Select the icon depicting the disconnected black and yellow plugs .

    -- or --

 Press F5.

2.2 Connecting PCPro to the System

Use the Connect dialog box to specify connection parameters to connect to the 
system.  

Figure B-2  Connect Dialog

3)  (Optional) Load 
a defined 
Connection 
Account (can skip 
steps 1~3 by using 
this option).

1)  Select 
Connection Type.

2)  To login, specify 
the User Name and 
Password.

4)  To make the 
connection to the 
system, click 
Connect.
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To make a connection between PCPro and the system:

1. Select a Connection Type and specify the settings relevant to the 
selected type.  

2. Specify the User Name and Password used to allow the connection.

3. Alternatively, steps 1~2 can be skipped loading a defined connection 
account (refer to  - Connection Accounts).

4. Press the Connect button.

After a successful connection, the connection settings that are used are 
set to the File Properties.

2.2.1 Connection Types

PCPro supports three types of connections to a SL2100 system.

Connection Types for SL2100: 

 IP
An IP Connection can be made via a LAN or the Internet. The IP 
address specified should match the system setting 10-12-01. If 
connecting to the Ethernet port on the VoIP daughter board, use the 
IP address setting in 10-12-09.

 Dial-up
An IP Connection via Dial-up can be made via a dial-up connection, 
either through ISDN or an analog modem.   

 Outbound IP
Use this setting along with the IP connection if the listen port number 
needs to be changed to match the destination system configuration 
The listen port number should match the value of 90-54-02 on the 
system. And the IP address of the PC should match the value of 
10-12-01 or 10-12-09.

TIP

❍ If connecting to an SL2100 system, select either IP or IP via 
Dial-up or Outbound IP.

NOTE


❍ Modem connections require an EXIFB  mounted to the 
CCPU. The inbound trunk can be DID to the modem 
access (PRG 11-15-14 Default 740) or can go through the 
auto attendant with an option pointed at 740.

❍ To configure a dial up connection, refer to section 2.2.2 
Create SL2100 Dial Up Connection on page B-4.
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2.2.2 Create SL2100 Dial Up Connection

When connecting an SL2100 via modem, a Dial Up Connection (PPP) must 
be created. The following steps describe how to set up the Dial Up 
Connection (PPP).   

1. Click Start > Settings > Network Connections.

2. Select Setup a New Connection or Network.  

3. Click Next.

NOTE


Modem connections require an EXIFB  mounted to the CCPU. The 
inbound trunk can be DID to the modem access (PRG 11-15-14 
Default 740) or can go through the auto attendant with an option 
pointed at 740.

Figure B-3  New Connection Wizard Dialog
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4. Select Connect to a workplace, then click Next.  

Figure B-4  Network Connection Type Dialog
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5. Select Dial directly.  

6. Enter the destination phone number, the name to be used for 
the dial-up connection and check the box next to "Allow other 
people to use this connection" then click Next.  

Figure B-5  Network Connection Dialog

Figure B-6  Connection Name Dialog
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7. Enter the login name (tech) and the password to be used 
(12345678) and check the box next to "Remember this 
password", then click Connect.   

  

IMPORTANT

Ensure the SL2100 programs 11-15-14, 22-02 and 22-07 
are setup to receive calls to the modem.

Figure B-7  Phone Number to Dial Dialog
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8. The PC will then try to dial the destination. Since this will be 
used later click Skip to stop the dial out.  

9. Click Close. 

Figure B-8  Connection Availability Dialog

Figure B-9  Completing the New Connection Dialog
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10. The Connection will now appear in the network connection 
screen and can be used by PC Programming when needed.  

2.2.3 Login

Specify the User Name and Password that will allow the connection. The 
account must exist within the chassis settings 90-02. Like PCPro Accounts, 
Login Accounts govern what system data can be accessed from the 
chassis.

It is important to note, Login Accounts are not the same as PCPro 
Accounts. Thus both chassis Login and PCPro Account settings are NOT 
synchronized and are independent of each other.

Once connected, the PCPro access level changes to match the level 
assigned to the user name/password used to connect. This access level is 
set in 90-02 on the chassis. For example, if you start PCPro in Installer (IN) 
mode, but connect to a chassis using an account with an access level of 
System Administrator Level 1 (SA), after connecting PCPro assumes the 
access level of SA. Once you are disconnected, PCPro reverts back to the 
access level IN.

Figure B-10  Connect SL2100 Dial Up Connection
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2.3 Disconnecting PCPro from the System

While PCPro is connected to a system, you can disconnect using one of the 
following methods:

1. Select the menu item Home:Communication > Connect/Disconnect.

    or…

2. Select the icon depicting the connected black and yellow plugs .

or…

3. Press F5.

All communication methods, excluding ‘Connect/Disconnect’, are disabled and 
the ‘Connect/Disconnect’ toolbar icon changes status to disconnected.

SECTION 3 DOWNLOAD

Downloading pulls all the data off the system and loads it into PCPro. A download 
can only occur when PCPro is connected to a system.

3.1 Accessing Download

When PCPro is connected to a system, access the Download dialog using one of 
the following methods.

 Select the menu item Home:Communication > Download.

    -- or --

 Select the icon depicting the blue arrow .

    -- or --

 Press F6.
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3.2 Downloading Data from the System to PCPro

Use the Download dialog to specify the parameters and perform a download. 

To download data from system memory to PCPro:

1. Select a Transfer Type.

2. Select Transfer Type items.

3. If desired, select items via the Modify Filter.

4. Press the Start button.

5. After the download is completed, press the Close button.

Figure B-11  Download Dialog

3)  Apply filter 
to help find 
items.

1)  Select 
Transfer Type.

2)  Select 
additional 
item(s) to 
download.

4) Click Start to begin 
download.

5) When completed, click 
Close.
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3.2.1 Transfer Type

Select a filter that controls the scope of settings to download. The following 
Transfer Types are made available.

 All: No filter, all chassis settings.

 Card Configuration: Card package settings.

 System Data Partial (System Wide): System-based settings.

 System Data Partial (Telephone): Telephone-based settings.

 System Data Partial (Virtual Extension): Virtual Extension-based 
settings.

 System Data Partial (Trunk): Trunk-based settings.

Transfer Type Items

Specifically select PRG Groups and/or individual PRGs from the chassis 
settings to download. The choice of Transfer Type Items available is 
governed by the Transfer Type selected.

Modify Filters

A  filter is applied based on the system data modification status. The filter 
only applies to system data on the PCPro side, not system data residing in 
chassis memory. Refer to  - Modification History for further information.

SECTION 4 UPLOAD

Uploading pushes all the data from PCPro to system memory. An upload can only 
occur when PCPro is connected to a system.

4.1 Accessing Upload

When PCPro is connected to a system, access the Upload dialog using one of the 
following methods:

 Select the menu item Home:Communication > Upload.

    -- or --

 Select the icon depicting the red arrow .

    -- or --

 Press F7.
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4.2 Uploading Data from PCPro to System Memory

Use the Upload dialog to specify the parameters and perform an upload. 

To upload data from PCPro to system memory:

1. Select a Transfer Type.

2. Select Transfer Type items.

3. If desired, select items via the Modify Filter.

4. Press the Start button.

5. After the upload is completed, press the Close button.

Figure B-12  Upload Dialog

3)  Apply filter 
to help find 
items.

1)  Select 
Transfer Type.

2)  Select 
additional 
item(s) to 
upload.

4) Click Start to begin 
download.

5) When completed, click 
Close.
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4.2.1 Transfer Type

Select a filter that controls the scope of chassis settings to upload. The 
following Transfer Types are made available.

 All: No filter, all Chassis settings.

 Card Configuration: Card packages settings.

 System Data Partial (System Wide): System-based settings.

 System Data Partial (Telephone): Telephone-based settings.

 System Data Partial (Virtual Extension): Virtual Extension-based 
settings.

 System Data Partial (Trunk): Trunk-based settings.

Transfer Type Items
Specifically select PRG Groups and/or individual PRGs from the 
chassis settings to upload. The choice of Transfer Type Items 
available is governed by the Transfer Type selected.

Modify Filters
A filter is applied based on the system data modification status. The 
filter only applies to system data on the PCPro side, not system data 
residing in chassis memory. Refer to  - Modification History for 
further information.

4.3 Uploading Card Configuration

When uploading the card Configuration via Upload All, and selecting Card 
Configuration, or just Uploading Card Configuration, a warning popup will 
display when either Trunks or stations are busy at the time of selecting to 
uploading the Card Configuration. This will allow for the upload to be canceled 
and completed at a later time, or to be continued and will disconnect the busy 
trunks and/or stations. 
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This popup is shown when the Card Configuration is selected to be uploaded and 
the trunks are busy.   

This is popup is shown when the Card Configuration is selected to be uploaded 
and stations are busy.  

SECTION 5 FEATURE ACTIVATION

Some system features are licensed and require registration before they can be used.  
Features can be activated by registering the feature automatically via the Internet or 
manually by downloading the associated Software Code. Feature Activation can only 
occur when PCPro is connected to a system.

5.1 Accessing Feature Activation

When PCPro is connected to a chassis, access the Feature Activation dialog by 
selecting the menu item Home > Maintenance > Feature Activation.

Figure B-13  Trunk Ports Busy Warning

Figure B-14  Station Ports Busy Warning
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5.2 Activating a Feature
Refer to  - Feature Activation for a detailed discussion.  

Figure B-15  Feature Activation Dialog
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SECTION 6 FIRMWARE UPDATE

Firmware Update automatically updates the main software in a system remotely at a 
scheduled time. This feature saves times and effort in comparison to performing the 
task manually. A Firmware Update can only occur when PCPro is connected to a 
chassis.   

The time to upload the firmware package file is directly related to the file size. 
At present, the package file is about 60MB, so over LAN it may take several 
minutes.

A backup of system data should be performed before any firmware update.

Figure B-16  Firmware Update Dialog
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6.1 Accessing Firmware Update

When PCPro is connected to a chassis, access the Firmware Update dialog by 
selecting the menu item Home > Maintenance > Upgrade SW.

6.2 Using Firmware Update

Use the Firmware dialog to specify the parameters and perform a Firmware 
Update.

To perform a firmware update:

1. Select a Firmware File.

Firmware Package File:
Select a Firmware package file provided by NEC. Updating a chassis with a faulty 
Firmware page file could render the system unusable.

2. Schedule when the Firmware Update is to occur using the parameters in 
the Schedule Update section.

Schedule:
Schedule when the Firmware update will occur. The changes of the 
Firmware Update will only occur after the chassis is reset. Thus the 
Firmware Update should be executed at a suitable time when the 
chassis is not actively in use.

3. Press the Start button.

NOTE


The time you specify should be relative to the time on the chassis, not 
the local time of the PC.
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6.3 SL2100 Web Pro Software Update

The Web Pro interface can be used to upload software updates to the SL2100, 
the procedure is similar to PC Pro Remote Upgrade. The update files have a “.bin”  
extension and are around 62M in size.    

1. Download update file to local PC.

2. From local PC connect to SL2100 Web Pro and login as tech / 
12345678.    

3. Select Maintenance from the menu bar.   

NOTE


This upgrade process takes approximately 15-20 minutes to complete.  During 
this process the phone system will be out of service.

Figure B-17  Web Pro Login

Figure B-18  Web Pro menu Bar
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4. Select Software Update.   

5. The Software Update screen will be displayed.   

Figure B-19  Web Pro Submenu – Software Update

Figure B-20  Web Pro Update Screen



Issue 1.0

SL2100 PC Programming Manual B-21

6. In the Manual Update box make sure both Upload from PC and 
Immediately Reset are selected.  

7. Click on the Browse icon and navigate the where the upgrade file is 
stored on the local PC, select the file and click Open.   

Figure B-21  Web Pro Manual Update Screen

Figure B-22  Choose File to Upload
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8. Click on Start icon to start update process. Do not exit Web Pro at this 
time!   

9. After several minutes the file upload will be complete but the update 
process has not finished. At this time exit Web Pro.   

Figure B-23  Web Pro File Selected

Figure B-24  Software Upload Completed Successfully



Issue 1.0

SL2100 PC Programming Manual B-23

10. After exiting Web Pro the update process will still be running and take 
approximately 12 more minutes to complete. You will know the update is 
complete when the telephones come back online.   

SECTION 7 CONDITIONS

WebPro supports Remote System Upgrade. WebPro upgrade requires”

 Firmware package file from NEC

 User level (PRG90-02-03) has to be 2 = IN (Installer Level) or higher.

 WebPro supports the following browsers:

 Internet Explorer 11.0 or higher

 Mozilla Firefox 45 or higher

 Chrome 48 or higher

 Edge 20 or higher  

Figure B-25  Web Pro menu Bar

 CAUTION

DO NOT click the Home or Back buttons on the browser, or close the WebPro 
browser, during uploading the Firmware, otherwise Upload stops.
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SECTION 8 SYSTEM INITIALIZATION

A System Initialization resets a system. During an initialization all telephone calls are 
dropped and all connections to WebPro, PCPro and the handset are lost.  Therefore, 
it is important that initialization should be executed at a suitable time when the 
system is not actively in use. PCPro can only execute an initialization when it is 
connected to a system.  

When PCPro is connected to a system, access the System Initialization dialog by 
selecting the menu item Tools > System Initialization.

8.1 System Initialization Type

Within the System Initialization Dialog, access the initialization process.

2nd Initialization
A 2nd Initialization resets the chassis and retains all previously modified values 
within system data.

Figure B-26  2nd Initialization Selected



SL2100 PC Programming Manual C-1 

Appendix C

SL2100

Copy

SECTION 1 OVERVIEW

The system data copy function allows you to copy data from one item to another 
(e.g., one trunk to another). This copy only applies to a single program. Copy only 
appears on screens where it is applicable.    

Figure C-1  System Data Copy

2) Specify copy source.

3) Specify copy 
destination.

4) Specify data to be 
copied.

5) Click OK to copy.

1) Select copy.
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SECTION 2 COPYING SYSTEM DATA

To copy a system data item: 

1. Press the Copy button .

2. When the Copy dialog box is displayed, specify the source to copy from.

The source (From) shows the item being copied from. Only a single source 
item can be selected.

3. Specify elements of the source that you want to copy.

These settings are specific to the system data being copied.

4. Specify the destination where you want to the elements copied.

The destination (To) details the item(s) where the selected source information 
is copied to. Multiple destination items can be selected.

5. Press OK to copy the selected items.
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Appendix D

SL2100

Modification History

SECTION 1 OVERVIEW

PCPro keeps a record of all the modifications made to a database file. This record is 
known as the Modification History. PCPro also provides you with the ability to view 
this history list. Following is the list of database operations that PCPro records in the 
modification history.   

The modification history is only saved in the local database when you perform File 
Save or File Save As. The modification history is a running list of the changes. 
PCPro keeps appending to the list. If you open a file, make changes, save and close 
the file and in the future open the same file and make additional changes, then the 
new modification history is appended to the old.

Operation Details

System Data Set This includes programming performed through:
 Standard View Screens

 System Data Programming

 Copy
For each set, an entry is made to the history list. The entry records the 
following items:   

Field Data

Date Date and time of operation.

User Name The User Name that performed the operation.

Display Name
The Display Name that performed the 
operation.

Access Level
The Access Level that performed the 
operation.

Type 
Identifies the operation type.  Set to “Set 
Date”.

Modification The system data ID.

Details
The item changed.
Old value.
New value.
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The modification state of a PCPro database is indicated via the modification icon on 
the Status Bar. The different filters are:    

SECTION 2 ACCESSING MODIFICATION HISTORY

To access Modification History, complete one of the following:

 Select the menu item Reports > Modification History.

               -- or --

 Select the clock icon on the toolbar .

SECTION 3 GENERATING A MODIFICATION HISTORY REPORT

A Modification History Report can be viewed in either HTML format or Comma 
Separated Variable (CSV) format. Sample formats are shown in Figure D-2 Sample 
Modification History HTML Format on page D-3 and Figure D-3 Sample Modification 
History CSV Format on page D-4.

To request a report:

1. Access the report by selecting Modification History from the toolbar or by
clicking the clock icon (refer to Section 2 Accessing Modification History).

2. When the Export Modification History dialog box is displayed, click either the 
HTML or CSV option and press OK.

The database is not modified. All data has been saved to file and uploaded.

System data has been modified and has not been saved to file.

System data has been saved to file but has not been uploaded.

System data has been modified and has not been saved to file nor uploaded.
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3. The report is generated in the format you selected. (Refer to Figure D-2 Sample 
Modification History HTML Format and Figure D-3 Sample Modification History 
CSV Format on page D-4).   

Figure D-1  Export Modification History Dialog Box

Figure D-2  Sample Modification History HTML Format



Issue 1.0

D-4

  

Figure D-3  Sample Modification History CSV Format
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Appendix E

SL2100

Connection Accounts

SECTION 1 OVERVIEW

Connection Accounts provide a convenient way of loading user defined connection 
settings. These are application wide settings.  Connection Accounts can be created 
in two ways:

 Via the Connect dialog

 Via the Connection Accounts dialog

SECTION 2 CREATING/DELETING A CONNECTION ACCOUNT USING THE 
CONNECT DIALOG

This section describes how to use the Connect dialog to create a new Connection 
Account or delete an existing Connection Account. (Refer to Figure E-1 Connect 
Dialog Creating/Deleting Connection Account on page E-2.)
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2.1 Creating a New Account

To create an account using Connect dialog:

1. Select a Connection Type and specify settings relevant to the 
Connection Type.

2. Specify the Login User Name and Password used to allow the 
connection.

3. Press the Save or Save As button located in the Connection Account 
section of the dialog.

4. When the Save As dialog is displayed, enter a description of the 
connection (refer to Figure E-2 Save As Connection Account Dialog on 
page E-3.)

Figure E-1  Connect Dialog Creating/Deleting Connection Account

Click Save or Save As to 
create a Connection 
Account.

Select the 
Connection Type. 

Specify the Login User 
Name and Password.

Select a Connection 
Account from the pulldown 
menu and click Delete a 
Connection Account.
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5. Press OK to save the Connection Account.

2.2 Deleting an Account

An existing Connection Account can be deleted.

To delete an existing account:

1. Select the Connection Account from the pulldown menu on the 
Connect dialog. (Refer to Figure E-1 Connect Dialog Creating/Deleting 
Connection Account on page E-2.)

2. Click the Delete button.

Figure E-2  Save As Connection Account Dialog

Enter the Connection 
Account description.

Click OK to save the 
Connection Account.
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Appendix F

SL2100

Debug Terminal 

SECTION 1 OVERVIEW

PCPro provides a debug terminal that can be used to capture trace logs from the 
CPU. The debug terminal communicates with the chassis via the LAN. A TCP 
connection on port 5964 is established between the debug terminal and the SL2100.

This port number is blank by default and must be set in PRG 10-20-01 Device 6. In 
addition, the DIM Access needs to be enabled in PRG 90-31-01. Any unused 
network port can be used as long as it is set in PRG 10-20-01 Device 6.   

Figure F-1  Debug Terminal Dialogs

1) Specify 
connection 
information.

2) Specify the 
log file to be 
used for data 
capture.



Issue 1.0

F-2

SECTION 2 LAUNCHING THE DEBUG TERMINAL

You can launch the debug terminal in one of two ways:

 Select the menu item Tools > System > DbgTerm.

    -- or --

 Click on the DbgTerm icon on the toolbar  .
  

If PCPro is connected via LAN to a chassis, then the debug terminal automatically 
tries to connect to the same IP address (domain name). Once the debug terminal is 
running, incoming debug messages from the chassis appear on the screen. You can 
capture the incoming data to a file by specifying a log file name and enabling the log 
capture.

Log capture can be enabled or disabled at the your discretion. A message is printed 
in the log file indicating the date and time the capture was enabled or disabled.



SL2100 PC Programming Manual G-1 

Appendix G

SL2100

Feature Activation

SECTION 1 INTRODUCTION

There are three methods for activation of features on the CCPU: automatic activation 
via PCPro, manual activation via PCPro and manual activation via WebPro.

SECTION 2 FEATURE ACTIVATION USING PCPRO

Some system features require registration before they can be used. Feature 
Activation registers these manually through input of Activation Codes. Feature 
Activation can only occur when PCPro is connected to a system.   

Figure G-1  PCPro Feature Activation Dialog

Hardware Key (number assigned 
by NEC and printed on equipment).

Informational area that lists features available for activation.  For each feature, 
the quantity registered, the activation status (On = activated, Off = not activated) and 

an expiration date for feature activation (if assigned) is displayed.

Manual  
Registration

Request html report 
for license.

Exit Feature 
Activation.
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2.1 Accessing Feature Activation

When PCPro is connected to a chassis, access the Feature Activation dialog 
by selecting the menu item Home > Maintenance > Feature Activation.
  

2.2 Manually Activating a Feature

Manual Activation does not require that you have an Internet connection.  
However, you must have previously downloaded the license file that was 
generated by the NEC Product License Server. The license file contains the 
Software Code, which is required to activate the feature.

To activate a feature manually:

1. Launch PCPro and access Feature Activation (refer to 2.1 Accessing 
Feature Activation).

2. If connected to the SL2100 system, the Hardware Code is retrieved and  
displayed.

3. Click Load File (refer to Figure G-2 Feature Activation Open File Dialog 
on page G-3).  

 CAUTION

This file can reside on the PC or you can copy it to a flash drive to 
reference if activating other locations.
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4. When you have located the file (xxxxxxx.lic), select it and click Open.

5. When the confirmation dialog is returned, click Save & upload now to 
immediately save the file on the ProPro database and activate the 
feature.

Figure G-2  Feature Activation Open File Dialog
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SECTION 3 FEATURE ACTIVATION USING WEBPRO

WebPro can also be used to manually activate features.

3.1 Manually Activating a Feature

To activate a feature using WebPro, you must have Internet connection.

1. Point your browser at the IP address of the CCPU (set in PGM 
10-12-01).

2. When the Home page is displayed, enter the User Name and 
Password.

The default User Name = tech and Password = 12345678. 

3. If login was successful, the WebPro Home page is displayed. Click 
Maintenance Icon. 

Figure G-3  WebPro Login Screen
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4. Select License Upload.   

Figure G-4  Feature Activation Screen WebPro Home Page

Figure G-5  Web Pro Submenu – License Upload
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5. The WebPro License Registration page is displayed.   

6. In the Upload a license file to the KTS field, click Browse to locate the 
license file (XXXXXXX.lic).         

7. When the Open dialog is displayed, select the license file and click 
Open.

Figure G-6  Feature Activation Screen WebPro Manual Activation

 CAUTION

The license file is obtained by accessing the NEC Product Activation 
Server, or by activating the feature using PCPro (refer to Section 3 
Feature Activation Using WebPro on page G-4).

TIP

This file can reside on the PC or you can copy it to a flash drive to 
reference if activating other locations.
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8. Click Upload to send license file to the system. When prompted to 
proceed, click OK.

9. If the license file upload is successful, the feature is activated.

Figure G-7  Feature Activation Open File Dialog WebPro
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Appendix H

SL2100

DIM File Download

SECTION 1 OVERVIEW

The DIM File Download feature supports downloading a DIM log file using PCPro. A 
DIM log file contains operational, system information, and critical information about 
the system.

SECTION 2 OPERATION

Use the following procedure to download a DIM log file using PCPro.

1. From the PCPro toolbar, select Tools > System > DIM File Download. A DIM 
File Download dialog box appears, Figure H-1 DIM File Download.   

      

NOTE


The DIM File Download menu is only available when PCPro is connected to the 
system.

Figure H-1  DIM File Download

NOTE


When the Download Dialogue runs, PCPro requests file information from 
"C:\\DATA\\*.txt"".  The Dialog Box displays all existing files with  
"C:\\DATA\\*.txt"".  
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2. Check the Download box next to the file(s) to download from the system.

3. Click OK. PCPro begins downloading the selected file(s) from the system. A 
status line on the bottom indicates which file is being downloaded at that 
moment. Refer to Figure H-3 DIM File Download Status on page H-3.

Figure H-2  DIM File Download Dialog Box
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Figure H-3  DIM File Download Status

 CAUTION

Limitation: 
The maximum file size that it is available to download with PCPro is 1MB 
per file. 

If the file is 1.5MB, the first 1MB will download, but the last 500 KB will 
not download.
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Appendix I

SL2100

Maintenance Features

SECTION 1 OVERVIEW

The following four features are supported:

 SRAM Information via Web / PC Pro.

 System Alarm display via Web Pro.

 T1/ISDN layer status display via Web / PC Pro.

SECTION 2 OPERATION

2.1 SRAM Information via Web Pro/PCPro

The following data is saved in internal SRAM and can be checked via Web/PC 
Pro. These are listed in PRG 93-xx. These programs are Read-Only, and cannot 
be accessed via User Pro.

The following user level can access the function:

1 = MF (Manufacturer Level)

2 = IN (Installer Level)

3 = SA (System Administrator Level 1)

 

Table I-1  Program Table 

Program No. Name Input Data (Read Only)

93-01-01 Day/Night Mode
Indicates current day/night mode 
per night mode service group.

1 = Mode 1
2 = Mode 2
3 = Mode 3
4 = Mode 4
5 = Mode 5
6 = Mode 6
7 = Mode 7
8 = Mode 8
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93-02-01 Automatic Transfer to Transfer
Indicates Automatic Trunk 
Transfer setting status.

0 = Disable
1 = Enable

93-02-02 Trunk Port Disable by Service 
Code
Indicates the Trunk Port Disable 
(Busy Out) status.

0 = Disable
1 = Enable

93-03-01 Call Forward - All/No Answer/Both 
Ring
Indicates Call Forward -All/No 
Answer/Both Ring setting status 
per extension.

0: = Call Forwarding off
1 = Call Forwarding with Both Ringing
2 = Call Forwarding when No Answer
3 = Call Forwarding All Call

93-03-02 Call Forwarding Destination for 
Both Ring, All Call, No Answer
Indicates Call Forward-All/No 
Answer/BothRing destination 
number set per extension

0-9, *, #, P, R,@
(Up to 24 digits)

93-03-03 Call Forward-Busy
Indicates Call Forward-Busy 
setting status per extension.

0:Call Forward-Off
1:Call Forward-Busy or No Answer
2:Call Forward-Busy

93-03-04 Call Forwarding Busy Destination.
Indicates Call Forward-Busy 
destination number set per 
extension.

0-9, *, #, P, R,@
(Up to 24 digits)

93-03-05 Call Forwarding – Follow-Me
Indicates Call Forward-Follow-Me 
setting status per extension.

Extension Number
(Up to 8 digits)

93-03-06 Call Forwarding Follow-Me 
Destination.
Indicates Call forwarding follow-
me extension number set per 
extension.

0 = Disable
1 = Enable

93-03-07 Do Not Disturb
Indicates DND setting status per 
extension.

0 = No setting
1 = DND External
2 = DND Intercom
3 = DND Transfer
4 = DND All

93-03-08 Message Waiting (Set)
Indicates extension number which 
you set Message Waiting.

Extension Number (Up to
8 digits)

93-03-09 Message Waiting (Receive)
Indicates extension number when 
left Message Waiting

Extension Number (Up to 8 digits)

Table I-1  Program Table  (Continued)

Program No. Name Input Data (Read Only)
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93-03-10 Alarm Clock 1
Indicates Alarm Clock 1 setting 
status.

0 = Disable
1 = Enable

93-03-11 Preset time at Alarm 1
Indicates the time set in Alarm 
Clock 1.

Time set in Alarm Clock 1.
When PRG 93-03-10 is "0", [00:00] is 
indicated.

93-03-12 Alarm Clock 2
Read only. Indicates Alarm Clock 
2 setting status.

0 = Disable
1 = Enable

93-03-13 Preset Time at Alarm 2
Indicates the time set in Alarm 
Clock 2.

Time set in Alarm Clock 2.
When PRG 93-03-12 is "0", [00:00] is 
indicated.

93-03-14 Forced Intercom Ring (ICM Call 
Type)
Indicates ICM Call Type per 
extension.

0 = Disable (Voice)
1 = Enable (Signal)

93-03-15 BGM
Indicates BGM setting status per 
extension.

0 = Disable
1 = Enable

93-03-16 Key Touch Tone
Indicates Key Touch Tone setting 
status per extension.

0 = Disable
1 = Enable

93-03-17 Dial Block
Indicates Dial Block setting status 
per extension.

0 = Disable
1 = Enable

93-03-18 Repeat Dial
Indicates Repeat Dial setting 
status per extension.

0 = Disable
1 = Enable

93-03-19 Headset Mode Switching
Indicates Headset Mode 
Switching setting status per 
extension.

0 = Disable
1 = Enable

93-03-20 Headset Ringing Mode Switching
Indicates Headset Ringing Mode 
Switching setting status per 
extension

0 = Disable
1 = Enable

93-04-01 Redial Data
Indicates the number stored in 
Outgoing call history.

Dial Data : 1~9, 0, *, #, P,R,@
(Up to 24 digits)

93-04-02 Name
Indicates the name stored in 
Outgoing call history.

Up to 12 characters

Table I-1  Program Table  (Continued)

Program No. Name Input Data (Read Only)
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93-05-01 Set Automatic transfer at 
Department Group Call
Indicates Automatic transfer 
setting status per Department 
Group.

0 = Disable
1 = Enable

93-05-02 Set Delayed Transfer at
Department Group Call
Indicates Delayed transfer setting 
status per Department Group.

0 = Disable
1 = Enable

93-05-03 Set Delayed Transfer at 
Department Group Call
Indicates Delayed transfer setting 
status per Department Group.

0 = Disable
1 = Enable

93-06-01 IP Address of the 1st Party CTI 
Client
Indicates the IP Address of the 1st 
Party CTI Client.

IP Address:
xxx.xxx.xxx.xxx

93-06-02 Availability of 1st Party CTI 
Connection
Indicates availability of the 1st 
Party Client connection.

0 = Not available
1 = Available

Figure I-1  Example of Program 93-01

Table I-1  Program Table  (Continued)

Program No. Name Input Data (Read Only)
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Figure I-2  Example of Program 93-02



Issue 1.0

I-6

Figure I-3  Example of Program 93-03
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Figure I-4  Example of Program 93-04
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2.2 System Alarm display via WebPro

The system alarm can be checked via WebPro. By clicking the System Alarm icon 
from the Maintenance Menu of WebPro, up to 100 alarm reports can be 
monitored. WebPro does not support an alarm report output.

The following user level can access the function:

1 = MF (Manufacturer Level)

2 = IN (Installer Level)

Figure I-5  Example of Program 93-05
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Figure I-6  WebPro System Alarm Submenu

Figure I-7  System Alarm Screen
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2.3 T1/ISDN Layer Status Display via WebPro

WebPro can monitor T1 / ISDN link status saved in PRG90-60 (T1/ISDN Layer 
Status Information).

This program displays layer status information for T1/PRI cards.

- = PRI card is installed but link is down

0 = Link is up

N/A = No PRI card is mounted.

The following user level can access the function:

1 = MF (Manufacturer Level)

2 = IN (Installer Level)   

Figure I-8  90-60: T1/ISDN Layer Status Information
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Appendix J

SL2100

WebPro HTTPS Support - Certificate 
Installation

SECTION 1 BROWSER SETTINGS FOR SUPPORT OF TLSV1

Select Tools > Internet Options > Advanced, and Enable TLS 1.0 as shown in 
Figure J-1 - Enabling TLS 1.0  

Figure J-1  Enabling TLS 1.0
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SECTION 2 CERTIFICATE INSTALLATION ON INTERNET EXPLORER

Access WebPro with a default NetBIOS Name of “SL2100” defined in program 
10-62-02 or IP Address defined in program 10-12-01 or program 10-12-09.

A Certificate Error occurs when WebPro is accessed with a PC browser when a 
Certificate is not installed. In this case, select Continue to this website (not 
recommended) as shown in Figure J-2 Continue to the Website.    

Figure J-2  Continue to the Website
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SECTION 3 INSTALLATION OF THE CERTIFICATE FROM THE WEBPRO HOME 
SCREEN

A Certificate error occurs when accessing the WebPro home screen. The Webserver 
certificate must be downloaded to your computer browser. To Install the Webserver 
certificate on the browser, click Certificate Error then click View Certificates.   

Figure J-3  Installing the Webserver Certificate
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SECTION 4 START-UP OF THE CERTIFICATE IMPORT WIZARD – CERTIFICATE 
INFORMATION

In the Certificate form, click Install Certificate. Refer to Figure J-4 - Install 
Certificate. 

Figure J-4  Install Certificate
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SECTION 5 EXECUTION OF THE CERTIFICATE IMPORT WIZARD – WELCOME TO 
THE CERTIFICATE IMPORT WIZARD

In the Certificate Import Wizard, click Next as shown in Figure J-5 - Welcome to the 
Certificate Import Wizard.  

Figure J-5  Welcome to the Certificate Import Wizard
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SECTION 6 EXECUTION OF THE CERTIFICATE IMPORT WIZARD – CERTIFICATE 
STORE

Select Place all certificates in the following store option. Click Browse, and then 
select Trusted Root Certification Authorities in Certificate store.

Click Next. Refer to Figure J-6 - Certificate Import Wizard – Certificate Store.  

Figure J-6  Certificate Import Wizard – Certificate Store
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SECTION 7 EXECUTION OF THE CERTIFICATE IMPORT WIZARD – COMPLETING 
THE CERTIFICATE IMPORT WIZARD

Confirm the following contents on “Completing the Certificate Import Wizard”.

1. Certificate Store Selected by User: Trusted Root Certification Authorities

2. Content: Certificate

Click Finish to complete the installation as shown in Figure J-7 - Completing the 
Certificate Import Wizard. 

Figure J-7  Completing the Certificate Import Wizard 
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Click OK on Certificate Import Wizard. Refer to Figure J-8 Completing Certificate 
Import Wizard.   

After completing the installation, restart the Internet Explorer browser. No warning 
message will appear while accessing the WebPro with the following URL:

Https://SL2100

Figure J-8  Completing Certificate Import Wizard

NOTE


With HTTPS connection, security warning of server certificate appears if you 
access the SL2100 by IP Address or NetBIOS, which is not default
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Appendix K

SL2100

Web Pro Load/Save to PC Feature

SECTION 1 OVERVIEW

WebPro supports Upload/Download feature of the PCPro database, configuration 
files and Remote System Upgrade.

SECTION 2 OPERATION

2.1 WebPro Load/Save PCPro Configuration File

Data Upload and Data Download options can be found under the maintenance 
menu area of Web Pro. These options are used to make a backup or to upload a 
stored database to the system. The file type is .sl2 which is the same type used by 
PC Pro.   

Figure K-1  WebPro – Data Download Submenu
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2.2 Load from PC

1. From the Maintenance menu choose Data Upload.   

2. Click the Browse icon and go the PC Pro configuration file location on 
the support PC.

3. Click the Upload icon to start the configuration file upload.

4. After upload is complete, ‘Load process completed’ is displayed and the 
system reboots automatically.

Figure K-2  WebPro – Data Upload Submenu
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2.3 Save to PC

1. Click the Data Download icon.  

2. Click the Download icon to start configuration file download.

3. When prompted, choose to save as and save on support PC with 
descriptive file name.   

4. When download is completed, ‘Saving process completed’ is displayed.

Figure K-3  WebPro – Data Download Submenu

Figure K-4  Save Completed Screen
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SECTION 3 CONDITIONS

 User level (PRG90-02-03) has to be 3 = SA (System Administrator Level 1) or 
higher.

 During loading or saving the configuration file, no other user can log into the system 
through PCPro, WebPro or Phone Programming. On the other hand, if someone is 
logged into the system, this feature does not work.   

 CAUTION
 

After completing the upload, the system reboots automatically, even if trunk 
lines and extensions are on a call. It is recommended WebPro Upload 
should be performed only when system is not in use.
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Appendix L

SL2100

Store Statistical Information of RTP

SECTION 1 OVERVIEW

The SL2100 can store RTP statistical information which can be downloaded in a log 
file using PCPro, or to USB via TEL Pro. A RTP log file contains operational, system 
information and critical information about RTP.

SECTION 2 OPERATION

Use the following procedure to download a RTP log file using PCPro.

1. From the PCPro toolbar, select Tools > System > RTP Information. A RTP
File Download dialog box appears. Refer to Figure L-1 RTP File Download. 

       

NOTE


The RTP File Download menu is only available when PCPro is connected to 
the system.

Figure L-1  RTP File Download

NOTE


When the Download Dialogue runs, PCPro requests file information from
“/etc/pyxis/data”. The Dialog Box displays all existing files with a ".csv” 
extension in that folder.
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2. Check the Download box next to the file(s) to download from the system.

3. Click OK. PCPro begins downloading the selected file(s) from the system. A 
status line on the bottom indicates which file is being downloaded at that 
moment. Refer to Figure L-3 RTP File Download Dialog Box (showing 
complete) on page L-3.

Figure L-2  RTP File Download Dialog Box
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SECTION 3 DATA FIELDS

GUIDE TO FEATURE PROGRAMMING

Figure L-3  RTP File Download Dialog Box (showing complete)

Table L-1  Data Fields

Data Name Data Outline

Start Date The date when the call has started

End Date The date when the call has ended

Ext/TRK Number

Ext/TRK Number (Call Partner)

Cumulative Cnt Receiving RTP packet loss total

Max Fraction Lost When the max packet loss rate and the average packet loss 
rate are the same value, the packet loss is occurring 
constantly. When the max packet loss rate is high compared 
with the average packet loss, it is regarded as a temporary 
packet loss.
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Average Fraction Lost When exceeding 1%, reconsideration of the network 
environment is needed.

Number of Sent RTP packets Number of Sent RTP packets

Number of Received RTP 
packets

Number of Received RTP packets

Cumulative Cnt (Remote) Receiving RTP packet loss total of Remote side (IP 
Terminal, IP Trunk, etc.).

Max Fraction Lost (Remote) The max packet loss rate of the remote side.

Max Round Trip Time (Remote) The maximum round trip time of a packet.

Number of Sent RTP packets 
(remote)

The number of Sent RTP packets (remote)

Sender Statistical Information on System Side

Sent Sender Report Ntp 
Timestamp

Sent Sender Report Ntp Timestamp

Sender SSRC DSP of VOIPDB determines SSRC at random at the time of 
channel opening.

Receiver Statistical Information on System Side

Max Inter Arrival Jitter The max interval of the arrival time of an RTP packet.

Average Inter Arrival Jitter The average interval of the arrival time for an RTP packet.

Remote Sender SSRC DSP of VOIPDB determines SSRC at random at the time of 
channel opening.

Receiver Information of Remote Side

Average Round Trip Time Average round trip time

Sender Statistical Information on Remote Side

Sent Sender Report Ntp 
Timestamp

Sent Sender Report Ntp Timestamp

Sender SSRC DSP of VOIPDB determines SSRC at random at the time of 
channel opening.

Receiver Statistical Information on Remote Side

Max Inter Arrival Jitter The max interval of the arrival time of an RTP packet.

Average Fraction Lost When exceeding 1%, reconsideration of the network 
environment is needed.

Average Inter Arrival Jitter The average interval of the arrival time of an RTP packet.

Table L-1  Data Fields (Continued)

Data Name Data Outline
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SECTION 4 GUIDE TO FEATURE PROGRAMMING

This guide provides a list of associated Programs that support this feature.  

Remote Sender SSRC DSP of VOIPDB determines SSRC at random at the time of 
channel opening.

Optional Information 

Type 0: ICM MLT/STD SIP
1: TRK SIP/H323
4: SL NET

Src systemID Source System ID

Src port Source Logical Port

Des systemID Destination System ID

Des port Destination Logical Port

Table L-1  Data Fields (Continued)

Data Name Data Outline

Program/
Item No.

Description/
Selection

Assigned Data Default Level

11-10-54 Service Code Setup (for 

System Administrator) – 

Save Store Statistical 

Information of RTP
RTP Information is saved to the 
CPU. Although saved every 
1000 calls, it is saved instantly 
with input of this service code.

(Up to 8 digits) 671 1

20-07-35 Class of Service Options 

(Administrator Level) – 

Save Statistical Information 

of RTP
Enable this option to give ability 
to enter service code 671 to 
save Statistical Information to 
the CPU

0 = Disable

1 = Enable

(COS 1~15)

COS 1~14 = 0

COS 15 = 1

1
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SECTION 5 RTP LOG INFORMATION

1. Stations

*1 - Statistical RTP Information is available if call uses VoIPDB.

*2 - Statistical RTP Information is available if terminal supports RTCP.

2. Trunks

*1 - Statistical RTP Information is available if remote side is supporting RTCP.

Conditions

 When RTP is closed and reopened by hold, transfer, etc., it is saved as a separate 
call.

 The saved RTP information is written to the CPU every 1000 calls. Once saved, the 
information is deleted from CPU RAM.

 When a write error occurs during save to the CPU, the file save is canceled, and the 
information is deleted from CPU RAM.

Table L-2  Stations

Terminal Type Applied/Not 
Applied Terminal *1

Applied/Not Applied 
Terminal *2 Remarks

IP7WW-12TXH-B1 No No

IP7WW-24TXH-B1 No No

IP7WW-8IPLD Yes No

SLT No No

Standard SIP 
Phone

Yes Yes

Table L-3  Trunks

Trunk Type Applied/Not 
Applied System *1 Remarks

Analog Line No

ISDN (PRI) No

SIP Yes

H323 Yes

SL Net Yes
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 The CPU considers saving RTP information a low priority so it does not affect other 
services.

 When saving RTP Information to the CPU, and 30 MB or less is available on the 
CPU, previous RTP files are deleted until 30 MB or more is available.

 When the remote side does not support RTCP, only the RTP information of the 
system side is available. All RTP information on the remote side will be set to 0.

 The RTP Statistical information of VoIP on the Secondary side of SL Net will be 
saved by the Primary system.

 For this feature PRG 20-07-35 must be enabled (1).

 To save RTP information, at idle phone press [Speaker], 6, 7, 1.
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